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GEODICT GUI, MENU, AND TOOLBAR 

This handbook describes the basic elements of the GeoDict GUI (Graphical User 
Interface). The standard GUI is partitioned into: 

◼ Menu bar (see page 4), that gives access to the main features of GeoDict, 
◼ Toolbar (see page 3), that provides several shortcuts to the most common 

tools, 
◼ Project Status section (see page 39), where information about the current 

project is shown and the loaded structure and volume fields can be edited in 

the right-click menu, 
◼ Module section (see page 50), where commands and their options for the 

chosen module can be selected, 
◼ Visualization area and Visualization panel (see page 51), where the 

structure is shown and visualization settings can be made,  
◼ GUI Sidebar (see page 56), where modifications of the visualization or the 

structure can be made, 

◼ Recent Files and Folders section (see page 2), which shows the last used 
folders and files on the start screen, 

◼ Console and Notifications (see page 77), that display messages from 
GeoDict. 

Visualization area and Visualization 
panel 

Toolbar 

Module section 

Console & Notifications 

Menu bar 

Recent Files and Folders 
section 

GUI 
Sidebar 

Project Status 
section 
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At the program start, the heading for the Module section is for one of the licensed 

modules, e.g., the FiberGeo module. The Visualization area shows the program’s 
splash screen. 

When a structure model is displayed, a 
Visualization panel with several tabs 

appears above the Visualization area 
to control the visualization of the 
structure or the results computed for it. 

 

 

 

 

 

 

 

 

 

 

This handbook does not describe all features that can be accessed through the GUI. 
Features described in separate handbooks are not described here again. In this case, 

only a link to the handbook is provided.  

A first overview of how a basic workflow in GeoDict might be performed is described 
in the First steps in GeoDict tutorial. 

 

RECENT FILES AND FOLDERS 

If no structure is in memory and the initial splash screen is shown, the Recent Files 

and Recent Folders sections are visible below. There, the Name, Size and date 
when it was last modified are shown. Clicking on a file opens it directly in the 
Visualization area or the Result Viewer. Clicking on a folder changes the current 

project folder.  

 

 

 

Visualization area 

Visualization panel 

http://www.geodict.com/Support/tutorials.php
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TOOLBAR 

The Toolbar displays tools for selected functions, mostly included in the Menu bar, 
frequently used in GeoDict. Resting the mouse pointer over a tool for a moment 
prompts a tool tip explaining the function. 

 

The selecting and editing functionality of Voxel Selection, GAD Object Selection, Paint 

and Metrology are part of the GUI Sidebar, and thus, are explained below starting on 
page 57.  
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MENU BAR 

The Menu bar contains the menus: File, Import, Model, Analyze, Predict, Export, 
View, Settings, Macro, GeoApp, and Help. Their functions are accessible by 
scrolling down in the pull-down menus.  

 

FILE 

The File menu entries are organized into panels: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

OPEN FILES, PACK AND LOAD RESULTS, PROJECT FOLDER 

Open Structure (*.gdt, *.gad) 

Select Open Structure (*.gdt, *.gad) … to open a saved generated structure file 

in GDT format (GeoDict compressed format) or in GAD format (GeoDict analytic 
data). Such files are usually saved and, thus, located in a personal project folder 
created by the user for the current project. 
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Open recent file 

Select Open recent file… to choose a file from a list, which is also shown in the 
Recent Files section (see page 2), with the files opened or created in the last GeoDict 

session. 

Open Results (*.gdr) 

Select Open Results (*.gdr)… to open and load result files in GDR format (GeoDict 
results), obtained from a previous run of a GeoDict solver or structure generator, and 
saved in the project folder.  

The toolbar icons  and  are the shortcuts to open structures and results. 

Clean-Up / Pack Results (*.gdr) 

Clean-Up / Pack Results (*.gdr)… allows to choose a result file and its result folder 
and to decide how the files that it contains should be handled. 

 

 

Choosing Clean-Up as Pack Mode, the user 
can decide if a particular File Type in the 
results folder should be kept or deleted. The 

results folder with the kept files and the 
chosen result file can be packed as ZIP-folder 

if Pack is chosen as Pack Mode. The original 
files can be kept or deleted after packing 
(Delete Original Results Folder after 

Packing). 
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Load Volume File 

Select Load Volume File… to open volume files and visualize the contained volume 
fields, e.g., *.vap files (velocity and pressure) located in the result folders. The user 

can open and load result files for visualization in numerous formats. 

 

 

 

 

 

 

 

 
 

If a compressed volume field is opened, it is possible to load the field in compressed 
form or to decompress it during loading. A compressed field is saved when checking 
Write Compressed Volume Fields under the Solver tab of the LIR Solver Options 

dialog. Notice, that some operations and visualization features of volume fields are 
available only if the field is loaded in uncompressed form. 

Load Particles 

Select Load Particles… to open and visualize particle trajectories and particle 
positions for FilterDict or AddiDict simulations (*.gpt and *.gpp files). This option is 

only available if a structure is currently loaded into GeoDict. 

Choose Project Folder 

For Choose Project Folder a sub-menu opens when hovering above. Click Select 
Project Folder… to open the Choose Project Folder dialog. Find the path to a 

previously created and already listed project folder, or right-click in the dialog to 
create a new project folder to save the results and settings files produced with 
GeoDict. 
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Follow Choose Project Folder → Options… to set up how the project folder is 

selected at the start of GeoDict. Last project folder, or a Fixed project folder can 
be selected. 

Click Open Project Folder to open the currently selected project folder with the 
Windows Explorer. Below, if available, the last project folders are listed as it is done 
in the Recent Project Folder section (see also page 2). 

The project folder will contain the files with the generated structures and the result 
files from the solvers’ computations.  

The location of the project folder is defined by the user at his/her convenience. The 
initial project folder for the first start of GeoDict, is located in Windows, by default 
at...  

 

SAVE STRUCTURE, IMAGE, VIDEO, TRIANGULATION, OR VOLUME FILE 

Save Structure 

Select Save Structure as… to save the generated structure in the supported file 

formats (GDT, GAD, leS, and RAW).  

 

 

 

 

The toolbar icon  is the shortcut to this function. 
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The automatically chosen folder to save the file containing the structure data is the 

current project folder. But it is also possible to choose another location. 

Save Image 

Choosing Save Image as… saves the current image in the supported file formats 
(*.png, *.jpg, *.xpm, *.xbm, *.bmp, *.pgm, *.ppm, and *.pbm) in the project 

folder. The toolbar icon  is the shortcut to this function. The opening dialog is 
different depending whether 2D view or 3D view was previously selected. 

For 2D images, in the Save Image dialog that opens, select first where to place the 

legend in the image.  

 

◼ Choose Attached to place the legend outside of the image but attached to it. 
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If this is selected, the resolution can be selected automatically or manually by 

defining a zoom factor. Uncheck the Automatic Resolution box, to set the zoom 
factor.  

◼ Choose Overlay as the Legend Placement to allow that the legend overlaps the 
image. 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this case, the user can choose to save the image with the Current Resolution, 
to define a Custom Resolution or to use the Preset resolution values that fits 

best. 

A preview of the image is shown in the right part of the dialog. Click OK to select the 
settings. 

Choose a file name and an image format and save the image by clicking Save. 

 

 

 

 

 

 

 

For 3D images, choose the resolution to save the image with the Current 
Resolution, define a Custom Resolution or use a Preset resolution. 
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Select Crop all empty space to reduce the image size by removing all borders in 

background color.  

If this is selected, the image can be embedded in borders with the background color 

(Embed after cropping). The number of pixels for each border can be defined 
separately in this case.  

Finally, check Save with transparent background to save the image without a 

background color. 

Save Video 

Selecting Save Video as… opens the Create Video dialog, which allows choosing 
preset scripts that execute the making of a video with appropriate standard settings. 

The preset video scripts are organized in the two tabs 2D and 3D. Clicking on 
Generate Videos opens the Save Videos dialog, where the output options like the 
video file name can be entered. The video is then created without any modifications 

of the underlying script. Click Open Video Editor to open the Video Editor for 
modifications. Edit Video Preset allows to change the description of the video 

preview.  
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The following preset movie clips are available:  

◼ In 3D: Clipping X, Clipping Y, Clipping Z, Fly-by, Follow Particle, Particle 

Animation, Rotate X, Rotate Y, Rotate Z, and Streamlets. Also given is 
the option to import settings from the Video Dialog 3D to be listed in the preset 

video scripts (Import as Video GeoApp), to produce a 3D video using 2D 
images from a stack of scanned images (Create Video from Image Stack), 
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and to simply open the Video Dialog 3D editor without loading a specific preset 

video script (Open Editor). 

◼ In 2D: Back To Front (all slices), Back To Front, Front To Back (all 

slices), Front To Back, Import as Video GeoApp, Create Video from 
Image Stack, and Open Editor. 

See the Create Videos handbook for more details about creating videos in GeoDict. 

 

 

 

Save Triangulation 

Select Save Triangulation as… to save triangulations obtained by creating a mesh 
through MeshGeo or by importing in ImportGeo-CAD. 

Save Volume File 

Select Save Volume File as… to save simulation results in several file formats. For 

example, after running a flow simulation with FlowDict, select a name to save the 
field of the velocity in X-direction as raw float data (*.vol) or GeoDict universal file 

(*.guf). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The use of Save Image as... and Save Video as… are excellent and easy-
to-use choices when the user intends to present to the public structures and 
visualized results after working with GeoDict. 

The high resolution achievable when saving images or videos this way is 
suitable for press-ready flyers and posters. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=CreateVideos&release=2023&heading=Cleanse
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DISCARD STRUCTURE OR SIMULATION RESULTS 

Selecting Discard Structure and Volume Files makes the structure, and all 
simulation result fields available for this structure, disappear from memory and from 

the Visualization area. The initial GeoDict splash screen appears in the Visualization 
area instead. 

In the example shown here, a fiber structure is loaded in GeoDict, together with the 

volume fields of velocities in X-, Y- and Z-direction, loaded from the .vap file of a flow 
simulation.  

Clicking Discard Structure and Volume Files 
removes the structure, and the simulation result 

fields (volume fields) from the memory. 

 

 

 

 

 

 

 

 

 

 

 

 

Selecting Discard Volume Files eliminates only the simulation result fields (volume 
fields) of the structure displayed in the Visualization area from memory. 
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In the same way, for a particle simulation result (created with FilterDict or AddiDict), 

if particle trajectories or positions are available in GeoDict memory, Discard 
Particles removes the particle information from memory. 

A structure in STL format (Stereosurface triangulation language), imported with 
ImportGeo-CAD, and shown in the Visualization area, is deleted from memory when 

Discard Triangulation is selected.  

CLEAR RECENT FILES / FOLDERS 

Clicking Clear Recent Files / Folders clears the list of Recent Files and Recent 

Project Folders shown in the GUI. 

MANAGE FLOATING LICENSE, CHOOSE LICENSE FILE, AND QUIT 

Clicking Manage Floating License… allows a floating license user to choose which 

of the licensed modules he would like to use in this session. Deselected modules will 
be shown as unlicensed in GeoDict’s menu, and their license will then be free for other 

users to use. 

Select Choose License File… to select a license file, e.g., to change the license from 

evaluation to purchased or leased license, to upgrade the license for another term, or 
to request a new license file following the procedure explained in Licensing GeoDict 
in the Download, Installation and Licensing handbook of this User Guide. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Selecting Quit ends the current GeoDict session. 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=DownInstallLicense&release=2023&heading=Cleanse


GeoDict Graphical User Interface – Menu bar 

GeoDict 2023 User Guide  15 

IMPORT 

Accessible from the menu bar are interfaces to import image and structure files into 
GeoDict (ImportGeo). 

For many image file formats, ImportGeo can perform 3D processing on gray value 
images and import them to the index image characteristic of GeoDict. The extraction 

from gray value images is done by segmentation, a procedure to convert them to 
index values. ImportGeo can also be used to load, import, and visualize a structure 
in the formats supported by GeoDict. 

ImportGeo-Base always appears in the menu because it is included in the GeoDict 
Base Package, other modules that have not been licensed appear under unlicensed 

in the list.  

Start an ImportGeo module by clicking Import in the menu bar and selecting one of 
the sub-modules available to import a file into GeoDict. If a module is selected, a dot 

appears in front of it in the module list and the module section changes to show this 
module. 

For complete information on interfaces to GeoDict see: 

◼ the ImportGeo-Base handbook (here, also an overview of all supported file formats 
can be found), 

◼ the ImportGeo-CAD handbook,  

◼ and the ImportGeo-Vol handbook of the User Guide. 

MODEL 

The Model menu gives access to the list of modules for digital material modeling that 

are included in the user’s license. GadGeo, ProcessGeo, and LayerGeo can always be 
used because they are included in the GeoDict Base Package. Other modules that 
have not been licensed appear in the list under unlicensed.  

The GeoDict modules for digital material design available for licensing are: 

The complete information on the individual modules can be found in the module’s 
handbooks: 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoBase&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoCAD&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoVol&release=2023
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◼ FiberGeo handbook 

◼ PaperGeo handbook 

◼ GrainGeo handbook 

◼ FoamGeo handbook 

◼ WeaveGeo handbook 

◼ GridGeo handbook 

◼ PleatGeo handbook 

◼ GadGeo handbook 

◼ ProcessGeo handbook 

◼ LayerGeo handbook 

◼ MeshGeo handbook 

 

ANALYZE 

The Analyze menu gives access to the list of modules for digital material analysis 
that are included in the user’s license. Modules that are not licensed appear in the list 

under unlicensed. 

The GeoDict modules for digital material analysis available for licensing are: 

The complete information on the individual modules can be found in the module’s 
handbooks: 

▪ FiberFind handbook 

▪ GrainFind handbook 

▪ PoroDict handbook 

▪ MatDict handbook 

▪ GeoDict-AI handbook 

 

PREDICT 

The Predict menu gives access to the list of modules for the prediction of material 

properties that are included in the user’s license. Modules that are not licensed appear 
in the list under unlicensed. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FiberGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=PaperGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GrainGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FoamGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=WeaveGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GridGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=PleatGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ProcessGeo&release=2023&heading=Dilate
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=LayerGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MeshGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FiberFind&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GrainFind&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=PoroDict&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MatDict&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GeoDictAI&release=2023
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GeoDict modules available for prediction of material properties are: 

The complete information on the individual modules can be found in the module’s 
handbooks: 

▪ DiffuDict handbook 

▪ ConductoDict handbook 

▪ FlowDict handbook 

▪ ElastoDict handbook 

▪ FilterDict handbook 

▪ AddiDict handbook 

▪ SatuDict handbook 

▪ AcoustoDict handbook 

▪ BatteryDict handbook 

  

EXPORT 

Accessible from the menu bar are interfaces to export structure files, images, and 

simulation results from GeoDict (ExportGeo) to many other software packages. 

To export a GeoDict file to other formats, select Export in the menu bar, and choose 
between ExportGeo-Base, ExportGeo-CAD, ExportGeo-Fluent, ExportGeo-Abaqus and 

ExportGeo-MicroMacro.  

With ExportGeo, structures from GeoDict can be exported to other formats so that 
files produced by the GeoDict user are compatible with other software and can be 

used for customized workflows:  

⚫ ExportGeo–Base converts voxelized data to RAW, VOL, PNG and Avizo Binary File 
(.am) formats. Furthermore, it converts analytic data, particles, trajectories and 

streamlines to GeoDict’s GAD format. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=DiffuDict&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ConductoDict&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FlowDict&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ElastoDict&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FilterDict&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=AddiDict&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=SatuDict&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=AcoustoDict&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=BatteryDict&release=2023
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⚫ ExportGeo-CAD converts voxelized or analytic structures to commonly used 

surface triangulation and CAD formats like STL, VRML, or Parasolid. 

⚫ ExportGeo-Fluent and ExportGeo-Abaqus convert voxelized data to formats for 

flow and heat computations with Fluent™ or elasticity computations with Abaqus. 

For complete information on interfaces from GeoDict, see the ExportGeo-CAD / 

MeshGeo handbook, the ExportGeo-Fluent handbook, and the ExportGeo-Abaqus 
handbook of the User Guide. 

VIEW 

After modeling a structure, either by generating it in GeoDict or after importing 3D 
µCT or FIB/SEM images, choosing between the View menu entries changes the 

visualization settings. A shortcut to many of these parameters can also be set through 
the Visualization Side Bar, as explained shortly below, starting on page 56, and in 
more detail in the Visualization handbook. 

 

 

 

 

 

 

 

 

The View menu allows to: 

◼ choose the visualization type to be 2D Cross Section (SEM), or 3D Rendering, 

with 3D Structure Renderer and the 3D View Ratio. 

◼ display the Visualization area in Full Screen which makes the Visualization area 

occupy the entire computer screen. Pressing the Esc key on the keyboard returns 
the program to the normal display. 

◼ select which components are displayed in the visualization. 

◼ choose the Legends / Overlays to be displayed. 

 

Some of these options are only accessible when choosing to visualize in 3D 
Rendering or when visualizing solver results (Volume Field, Streamlines, 

Particles, Triangle Mesh, Schlieren, Arrows, and Tensors). 

Choose Legend / Overlays → Detailed Settings to access the Visualization Side 
Bar, see page 56 and the Visualization handbook. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ExportGeoCADMeshGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ExportGeoCADMeshGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ExportGeoFluent&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ExportGeoAbaqus&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ExportGeoAbaqus&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023
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SETTINGS 

The Settings menu includes Color & Visibility Settings, Settings, Edit Expert 
Settings, Select Constituent Materials, and Edit Material Data Base. 

 

 

 

 

COLOR & VISIBILITY SETTINGS 

The default color settings applied to the 
background and materials during the 
generation with GeoDict, can be changed 

through the Color & Visibility Settings 
dialog, that opens from the GUI Sidebar on 

the right of the Visualization Area.  

If a structure is currently in memory, only 
the Material IDs present in the structure are 

editable in the Color & Visibility settings, 
otherwise all 256 Material IDs are displayed.  

First, decide whether the settings made 
should be applied directly to the structure in 
memory by checking Apply Immediately. 

Otherwise the Apply button must be 
pressed. 

A color preset is a particular group of colors 
that are applied together. Click Load Preset 
and, in the Load Color Preset dialog, select 

whether to display the generated structure’s 
materials using one of the presets. 
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Change all allows to change the color of all material IDs to the same color. By 

checking visible all material IDs can be set to be visible at once. 

Below, this can also be done for each material ID separately.  

Keeping a Color & Visibility Settings dialog open, instead of closing it, is helpful 
when trying to find the most adequate settings for a particular visualization.  

 

After selecting new colors through the buttons in the Color & Visibility Settings 
dialog, the current group of colors can be saved as a preset (Load Preset → Save 

as new Preset), to have it appear in the list of color presets later. 

 

More details about the GeoDict colors and visibility settings can be found in the  

Visualization handbook. 

 

 

 

 

Gray values 
(adaptive) 

Default Reversed gray values 
(adaptive) 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023
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SETTINGS 

Selecting Settings… from the Settings menu opens the Settings dialog to modify 
the general preferences or properties when working with GeoDict. The dialog contains 

the General, Parallelization and Statistics tabs.  

They contain a collection of settings that a user typically wants to apply to any GeoDict 
session.  

 

Resting the mouse pointer over the icons in the lower left of settings dialogs prompts 
a tool tip showing the icon’s function to appear. For example, if the chosen setting 

should not apply only to this GeoDict session but should also be chosen at the next 
GeoDict startup, the user must, after making his choices, first click the icon at the 

bottom of the dialog: 

 

After setting the current settings as start-up setting, click OK.  

The parameters entered in the Settings dialogs can also be saved into GPS (*.gps, 
GeoDict Project Settings) files and/or loaded from them.  

Clicking OK at the bottom of the dialog, results in carrying out the modifications and 

closing the dialog. Select Cancel to discard the modifications entered in the dialog. 
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GENERAL 

The first option under the General tab controls the size of the fonts used in the GUI 

at start-up (GUI Start-Up Font Size). 

For example, increasing the GUI Start-Up Font Size to 14 results in the display of 
a larger font overall in the GUI after restarting GeoDict. 

 

GeoDict automatically stores a copy of the previous 3D structure, before applying any 

changes to it, until the Memory for Undo is filled up. This allows to quickly undo any 
changes using the undo function:  

Disadvantage of keeping a copy of the last structure is that some runtime and hard 

disk space is required for saving the structures. Thus, it can be disabled by setting 
the Memory for Undo to 0 MiB. 

If Check for GeoDict Updates is checked, GeoDict will automatically search 
(requires internet connection) if updates are available and print a message if an 
update is found.  

GeoDict will not automatically download or install those updates.  

In the corresponding panels underneath are the options for disk usage (I/O), and for 
setting a default Text Editor. 
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I/O 

In the I/O (input/output) options, 
define how many days the log files, in 

which the events happening while 
running GeoDict are recorded, should 
be kept. 

Also define whether the time a warning 
message is displayed should be 

limited, and the time of the limitation in seconds. If 0 is selected, pop-up messages 
are not shown at all.  

Text Editor 

The user can set which text editor is to be opened automatically when editing macros 
and other editable files. Click Browse to search and set the path to the location where 

the executable for the favorite text editor is located. 

Timeout options 

The last two options are for floating license users only. Define after how many hours 

the Floater Release Timeout will be triggered. Then all non-required floaters are 
freed and are available for other users. This is especially useful if long-running 
computations are performed. The same behavior occurs when pressing the Release 

Floaters button in the progress bar during a simulation run.  

The Idle Timeout triggers if after the defined hours no computation or user 

interaction was made. Then all floaters, including also the GeoDict -Base floater, are 
freed and available for other users. It is possible to re-acquire the freed floaters when 
returning to the GeoDict application in the then opening dialog.  

PARALLELIZATION 

GeoDict Thread Parallelization 

The user can set the number of parallel processes (threads) GeoDict should use, e.g., 
for the visualization, for the image processing, and for the structure generation. It is 
possible to set the Thread Mode to Max. Thread Number which equals the Number 

of CPUs the machine has. When not all available CPUs of the computer should be 
used, perhaps to allow other users to work simultaneously on the same machine or 

to improve the running of other programs, the number of used parallel processes can 
be limited by setting a Manual Thread Number. 
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Choosing Automatic Thread Number uses the maximum number, if up to eight 

cores are available. If more than 8 cores are available, the maximum of 8 and the 
number of available cores divided by two is used. 

This option has nothing to do with the solver processes, which can be set for all 
GeoDict solvers in the Dict modules independently.  

Check Run external solvers with low priority to make the system more responsive 
when working interactively while a GeoDict solver (e.g. LIR or SimpleFFT) is running. 

Solver MPI Parallelization 

For cluster computations, set the environment variable that holds the location of the 
node file, i.e., the file that contains the list of assigned compute nodes. 

For MPI parallel computations, set the path to the MPI Installation that should be 
used for the parallelization. Select Automatic to look automatically for MPI 

installations. 

 

For more information, refer to the High Performance Computing handbook of this User 
Guide.  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=2023
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STATISTICS 

 

The Connected Components panel is found under the Statistics tab. A connected 
component is defined as a complete set of color voxels.  

Checking Show Number of Connected Components or Show Number of 
Connected Components in 2D Slice, and clicking OK, adds the number of 

Components 3D and Components 2D to the Statistics tab in the Visualization 
panel above the Visualization area. 

If the pore space is divided by the structure into several parts it can, with Count Pore 

Space as Single Component checked, be counted as one connected component. 
The pore space does not count as an object and does not add to the number of 

Objects. 

As example, a simple periodic structure model contains 10 spheres. At the corners, it 
is the same grey sphere that disappears and reappears on the other side. Two red 

spheres are also cut in half. They disappear and reappear in Z-direction. Three of the 
red spheres overlap and one of the red spheres touches a grey sphere. 

The number of Objects 3D is 10, but the number of Objects 2D is only 4 (2 grey 
and 2 red spheres) in the 2D-Slice 126 (move the slider under the Camera (Y,Z) tab). 
The pore space is not counted as object. 
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Now, see how the connected components in 2D are counted when checking Show 
Number of Connected Components in 2D Slice. The number of Objects 3D and 

2D are the same as before. For Show Number of Connected Components in 2D 
Slice, the pore space and the red-grey touching spheres are each counted as a 
connected component. Connected components in 2D are 5 (1 grey sphere + 1 partial 

red sphere (top) + 1 partial red sphere (bottom) + 1 [1 red sphere+1 grey sphere] 
component + 1 pore space). 

 

Next, Show number of Connected Components is checked and they are counted 
in 3D. Connected components in 3D are 13 (2 grey spheres + 4 partial grey spheres 

+ 1 red sphere + 4 partial red spheres + 1 [3 red spheres+1 grey sphere] component 
+ pore space). 
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Periodicity, Neighborhood Mode, and Component Mode define criteria for the 

connectivity of the components. 

For periodic structures, checking Periodicity in X-Direction, Y-Direction, or Z-

Direction affects the number of connected components. Objects that end on one side 
of the volume and reappear on the opposite side are counted as being the same 

connected component, decreasing the final number of connected components.  

For example, the structure shown above is periodic in Z-direction, and without 
checking periodicity, 5 connected components in 2D are counted (#1 grey sphere + 

#2 partial red sphere (top) + #3 partial red sphere (bottom) + #4 [1 red sphere+1 
grey sphere] component + #5 pore). 
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Next, checking Periodicity in Z-Direction decreases the number of connected 

Components 2D to 4, because the red sphere at the edge of the domain reappears 
at the opposite edge and is then considered the same connected component.  

 

The 4 connected components are: (#1 grey sphere + #2 red sphere (top+bottom) + 
#3 [1 red sphere+1 grey sphere] component + #4 pore). The number of Objects 

does not change, and the same four objects are detected in 2D. The pore space is not 
counted in the number of Objects. 

Neighborhood Mode 

Neighboring structure components can be connected through faces, edges, and 
corners of voxels, i.e., two voxels of the same color that share a corner point always 

belong to the same connected component.  

Checking Face is more restrictive than choosing 
Face or Edge, and this is more limiting than 

selecting Face, Edge or Corner.  

The Neighborhood Modes are explained using the 

example on the right. When choosing the 
Neighborhood Mode Face only the red and the blue 
voxel are neighboring (they also share edges and 

corners). When choosing Face or Edge the red and 
the blue voxel and the blue and the green voxel (they 

also share corners) are neighboring. Finally, if Face, 
Edge or Corner is chosen the red and the blue 
voxel, the blue and the green voxel and the blue and 

the yellow voxel are neighboring. 

pore = 4 

1 

3 

2 

2* 
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Component Mode 

For structures with more than one material, selecting Pore / Solid from the 
Component Mode pull-down menu determines whether the components are 

considered connected or not, based on being empty voxels (background) or solid 
voxels (structure), regardless of their color. When selecting Material ID, the Material 
ID (color) of the solid voxels (structure) is determinant for the components to be 

considered connected or disconnected.  

 

Periodicity: un-checked for all directions 

Neighborhood mode: Face 

5 connected components 2D = #1, #2 (half sphere 
top), #3 (2 spheres touching), #4 (half sphere 
bottom), and #5 pore.  

 

 

 

 

 

 

 

 

 

Periodicity: un-checked for all directions 

Neighborhood mode: Face 

7 connected components 2D = #1 (grey sphere), #2 
(half red sphere top), #3 (red sphere), #4 (grey 
sphere), #5 (1 blue overlapping voxel), #6 (half red 

sphere bottom), and #7 pore. 
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EDIT EXPERT SETTINGS… 

For many commands available in GeoDict’s modules, additional parameters exist that 
are not available through the dialog widgets that open in the corresponding modules. 

These parameters are also not stored in the parameter lists of those commands inside 
the python macros. By default, no expert settings are set, and well-chosen default 
values are used.  

Some expert settings allow to access experimental or unstable features. Others allow 
to access solver variants that are only useful in very special circumstances. In general, 

a user should not set any expert settings without consultation of Math2Market’s 
support.  

 

To activate an expert setting, after selecting Edit Expert Settings…, the user clicks 

Add Row to sequentially select the Module, the Command, and the Key that define 
the expert setting that should be edited.  

Clicking OK at the bottom of the dialog, results in carrying out the modifications and 
closing the dialog. Select Cancel to discard the modifications entered in the dialog. 
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The choices of module, command, and key are entered as columns into the first row. 

The user can now click the cell under Value and manually enter it. 
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SELECT CONSTITUENT MATERIALS 

A Constituent Material from the Material Database consists of a name for the raw 
material and the material’s physical properties and represents the properties of a 

material in a structure model. 

 

 

 

 

 

With a structure model in memory, showing 

in the Visualization area, select Settings → 
Select Constituent Materials to change the 
raw material of a Material ID or assign a 

material to a Material ID with undefined 
material in a structure model.  

For example, in a foam structure the Material 
ID 01, initially defined as Aluminum, can be 
changed to be made of Steel as follows: 
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If the new material is selected, close the dialog 
by clicking OK in the Material Selector dialog and 

Run in the Select Constituent Materials dialog. 
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EDIT MATERIAL DATA BASE… 

In GeoDict, constituent materials (and their physical properties) are globally 
assigned to a structure and not just to a property predictor simulation. 

The GeoDict Material Database is a catalogue of the constituent materials that can be 
assigned to correctly identify digital materials in the structure models with properties 
of real materials.  

The user can access and edit the GeoDict Material Database from many modules or 
select Settings → Edit Material Database… to directly access the catalogue from 

the menu bar. 

 

 

User-defined materials can be added to expand the 
GeoDict Material Database, or further properties 

can be listed for a material already included in the 
database. This is described in detail in the Material 

Database handbook of the User Guide. 

 

Each material in the database, together with its properties and description, is saved 
as a text-file with the name of the material. The user can edit these files in any text 
editor. The default GeoDict Material Database is located at: 

 

 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2023
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MACRO 

The Macro menu contains the entries Start Macro Recording, End Macro 
Recording, Execute Macro / Script, and Session Macro.  

 

 

 

The entry End Macro Recording can be 

selected only during the recording of a macro to 
end the recording. 

 

 

Macro recording and execution and the options Convert GMC to Python Macro, Re-

execute Last Python Script and GeoDict Cloud Projects are explained in detail in 
the Automation by scripting handbook of the User Guide. 

 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Automation&release=2023
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GEOAPP 

When selecting GeoApp in the menu bar a pull-down menu of GeoApps opens. The 
Shared GeoApps are apps delivered with GeoDict and apps the users create and 

share with their colleagues. Under MyGeoApps find an example GeoApp and the local 
GeoApps created by the user and placed in the GeoDict settings folder. The individual 

GeoApps are sorted by their application fields or the module they belong to. 

Selecting a GeoApp from the list opens the GeoApp 
section, located left of the Visualization area. It 

contains a pull-down menu that lists the available 
Python scripts for the corresponding GeoApp. 

When selecting one of the available scripts, the 

description area displays a report about the script. In 
the script, this report content can be found inside the 

apostrophes after Description = ''' ''' and can be 
edited at any time after opening the script with a text 
editor.  

For the NMR (Spherical Pore) script from the Digital Rock Physics (DRP) App, 
the text in the macro and the description area are shown here.  

Click the Options’ Edit … button to edit the parameters of the macro. To open the 
GeoApp in an editor, click Open Macro / Script File. Clicking Run executes the 

script. 

The GeoApp scripts listed in the pull-down menus can be found in the GeoDict 

installation folder in the subfolder GeoApp or in the subfolder of the corresponding 
module. 

More details about using GeoApps can be found in the GeoApp handbook of this User 

Guide. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GeoApp&release=2023
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HELP 

The Help menu links directly to several volumes of the User Guide on the GeoDict 
web page for information on installation and licensing of GeoDict, the introduction to 

the GUI, menu and toolbar, the Result Viewer for the result files, Visualization and 
video creation in GeoDict, using GeoDexcel and GeoLab and setting up high 

performance computing. 

 

 

All User Guide handbooks can be downloaded 

as a block in zipped .pdf format. 

Clicking About GeoDict opens a window 
giving information on GeoDict version, 

revision number, and licensing.  

 

We also acknowledge the third-party 
components used in GeoDict. 
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STATUS AND MODULES SECTION 

 

The Status and Modules section is divided into 
the Project Status Section and the Module 

Section. It can be collapsed by clicking on the 

 icon or expanded in a new window by 

clicking on the  icon. 

 

 

 

 

 

 

 

 

 

 

 

 

 

PROJECT STATUS SECTION 

The Project Status section displays (from left to right) the current CPU load, the 
currently used RAM and the percentage of Disk Space used on the drive where the 

project folder is located. This refers to all processes running on the computer, not 
only to GeoDict.  

Below, several information about the current project and the loaded files is shown.  

CURRENT PROJECT FOLDER 

First, the path of the Current Project Folder is given. This section can be expanded 
by clicking on the small triangle on the left or double clicking on the folder path. Then 
all GeoDict Result files (*.gdr) which are stored in the project folder are listed. Double 

clicking on a file name opens it directly in the Result Viewer. 

A right-click on the Current Project Folder row opens a menu used as shortcut for 
Choose Project Folder (see page 6 for details). 
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STRUCTURE 

The color dot in front of Structure shows whether any voxelized structure is loaded 
into GeoDict (green dot), or not (red dot). 

The Structure model is identified by File 
Name, Description, Voxel Count, Voxel 
Length, Domain Size and the internally 

hashed Structure ID number. A structure 
generated, e.g., with FiberGeo, GrainGeo, 

PaperGeo, WeaveGeo, GridGeo, or PleatGeo, 
with the same parameters and the same 

random seed, has always the same 
Structure ID number. The Structure ID 
number changes as soon as the structure is 

modified in any way.  

Right-clicking on the Structure row opens a menu used as a shortcut to apply 

modifications to the microstructure. 

 

Most of the commands in this menu are shortcuts to several functions included under 
the File menu in the menu bar (see page 4 ff.), in the ProcessGeo module (Model → 

ProcessGeo, see also the ProcessGeo handbook), or in the LayerGeo module (Model 

→ LayerGeo, see also the LayerGeo handbook). 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ProcessGeo&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=LayerGeo&release=2023
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The Adjust Voxel Length command 
can also be accessed by right-clicking on 

Voxel Length, where the current voxel 
length is shown in the selected units (m, 
mm, µm, nm, Inch). This length can be 

adjusted by changing parameters in the 
opening Adjust voxel length dialog. 

Here, also the unit for the voxel length 
can be selected from the pull-down 
menu at the top right of the dialog. The 

option Rescale all volume fields allows 
to change the voxel length of the 

currently loaded volume fields 
accordingly. Thus, a structure and its 
volume field can still be shown 

simultaneously in the visualization area.  

This change in voxel length occurs on the already generated structure (post-

processing). To vary voxel length for the generation of a new structure (pre-
processing), the value has to be changed through the Create → Options - Edit… 

button in the module section of the corresponding Geo module (FiberGeo, GrainGeo, 

WeaveGeo, etc.). 

Attention! The values inside the volume field are not changed! Thus, the volume 
field might not fit to the structure anymore,, e.g. if a velocity field is loaded. 
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When right-clicking on Description the 

description of the structure can be changed. 

 

 

 

 

 

 

 

GAD OBJECTS 

The color dot in front of GAD Objects shows whether analytical information about 
the objects inside of the current structure is available (green dot), or not (red dot). 

The dot is yellow when information about objects inside of the current structure is 

available, but this information does not describe the current structure completely. 
This may happen, for example, when the structure has been modified after the 

generation (e.g., with ProcessGeo or LayerGeo). 

Also shown is the number of GAD objects (such as fibers, grains, etc.) in the structure 
(GAD Object Number). 

Right-clicking on GAD Objects opens a list of possible modifications, like editing the 
GAD objects or the domain, creating, adding, deleting, scaling, shifting and rotating 

GAD objects, resolve overlap and mark contacts, change the Material ID model, or to 
create a GAD index image or an orientation image. All of these modifications can be 
accessed also from the module GadGeo and are explained in the GadGeo handbook 

of the User Guide.  

 

By choosing Algorithms, all manipulations of analytic objects, available in the section 
Algorithms of GadGeo can be accessed. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2023
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CONSTITUENT MATERIALS 

The next entry in the Project Status section is Constituent Materials. This block lists 
the materials that are present in the structure and are shown in the Material 

Information legend next to the microstructure in the Visualization area. 

Right-clicking on Constituent Materials gives access to the Select Constituent 
Materials dialog and is a shortcut to selecting Settings → Select Constituent 

Materials in the menu bar. Edit Material Database is a shortcut to Settings → 
Edit Material Database. The current temperature can be edited in the constituent 

materials dialog and also by clicking on Change Temperature , which opens a 
separate dialog. It is also possible to Set all Fluids to one chosen material and the 
same can be done for solids by clicking Set all Solids to. One can also Set Material 

Information for any Material ID. 

In the example shown here, two Constituent Materials are listed in the Project 

Status section (Air and Manual), corresponding to Air and Solid in the Material 
Information legend. The fibers with material ID 01 and material ID 02 are set to be 

made of the same constituent material. 

After changing the constituent material for material 
ID 01 to Aluminum and material ID 02 to Nickel, 

the number of Constituent Materials in the 
Project Status section changes from (2) to (3). 
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OPEN RESULT FILES 

Open Result Files shows the number and names of result files that are currently 
opened in the Result Viewer. 

VOLUME FILES 

The last entry in the Project Status section is Volume Files. After loading a result 
file and a corresponding volume file (e.g., after an effective stiffness simulation with 

ElastoDict-FeelMath-VOX), the name of the result file (Open Result Files) and the 
corresponding Volume Files appear in the Project Status section. Each of  the 

volume files consists of volume images and they contain several volume fields. In the 
example shown here the volume file StrainStressResult_xy.das is loaded. It has the 
volume images vonMisesStrain and vonMisesStress, and they contain a volume field 

with the same name, respectively. Double clicking on a volume field loads it into 
GeoDict and it can be seen in the Visualization area.  

Right-clicking on Volume Files opens a list of options. 
Discard and Load Volume File are the same as those 

from the File menu in the menu bar (see page 4 ff.). 
It is also possible to Create New Volume Files or to 
Create a Gaussian Random Field. 

A right click on a loaded volume file provides further options. 
Choose Properties to get information on the volume file 

loaded. This volume file can also be saved in the current project 
folder. With Create New Image two types of images can be 
created. If Scalar is chosen, an empty volume image is created 

and a new volume field can be created as shown below. If 
Vector is chosen a volume image with 3 volume fields 

(containing only zeros) is generated and also the norm is automatically computed and 
shown.  

 

Right-clicking on a volume image opens further options. 
Choose Properties to get information on the volume 

image and to change its name. The function 
Interpolate to Voxel Center interpolates the data to 
the voxel centers using the values on edges and faces 

of the voxels. If several volume files are opened it is 
possible to Copy or to Move a volume image into 

another volume file. With Remove a volume image can 
be deleted from the GeoDict memory. It is not deleted from the volume file saved in 
the project folder. 
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Finally, a right click on a 

volume field provides 
other possibilities, 

besides Properties, 
Save as .guf file, Move 

or Copy the field to 
another volume image, 
and Remove from 

memory, which are 
explained below. 

 

 

 

Compute Metrics 

With Compute Metrics, access 

statistical properties of the 
volume field. 

Enter a Result File Name 
(*.gdr) to save the results in. 
Then select on which of the 

loaded Volume Fields the 
properties should be computed. 

Choose which metrics should be 
computed. 

 

 

 

Minimum, Maximum and Mean 
Values, Standard Deviation and 
Variance can be computed for either 

Pore, Solid, All Materials, Chosen 
Materials or Chosen Material IDs. 

Minimal, Maximal and Mean Values 
can also be determined slice-wise for 
a chosen direction and Pore, Solid, All 

Materials, Chosen Materials or 
Chosen Material IDs. 

When checking Autocorrelation, 
further options appear below.  
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When Autocorrelation is 

selected, the similarity of 
voxels in a given distance 

between Minimal Length 
Scale and Maximal Length 

Scale is measured. This is 
similar to the MatDict 
command 2-Point Correlation 

and details are described in the 
MatDict handbook. 

 

The Correlation Length is a measure on which length scale the values of the volume 
field change. 

With Spatial Intensity Histogram a histogram of the values in the volume field is 
computed. 

Clicking Run computes the chosen metrics. After the run is finished the result viewer 
opens and shows the results in the report tab. Additional plots may be available in 
the Plots subtab. 

Threshold to Structure 

Select Threshold to Structure to create a structure with voxels above or below a 

defined threshold of a volume field. One or two thresholds can be defined. 

If 3D rendering was chosen before, for one threshold, check Preview Threshold in 

3D to visualize the created structure already before clicking Run. 

Define e.g. 2 thresholds to create a structure with voxels of ID 01 where the von 
Mises Strain of the fibrous structure is above 1e-06, and with voxels of ID2 at 

locations with von Mises strain above 4e-06. 

 

 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MatDict&release=2023&heading=TwoPointCorrelation
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Math Operation 

Choose Math Operation to open a dialog that allows to manipulate the volume field 

in different ways. Each math operation generates a new volume image containing the 
modified volume field. The volume fields can be saved in *.guf format or the modified 
volume file is saved, after the unwanted volume images were removed. 

◼ Normalize Field: define a new minimum and maximum value and normalize 
the values of the volume field accordingly. 

◼ Subtract Field: choose another volume field, e.g., from another result file, that 
will be subtracted from the current volume field. 

◼ Add Field: choose another volume field that will be added to the current one. 

◼ Compute Gradient: compute the gradient for the current volume field. 

◼ Convert to Data Type: choose a new data type (single, uInt32, uInt16 or 
uInt8) and convert all values of the current volume field to this type. 
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◼ Add (Subtract) Constant Value: add or subtract a constant value from the 

volume field. 

◼ Multiply Constant Value: multiply each entry in the volume field by a constant 

factor. 

With the tools from the status section volume fields can be saved as RAW-files. For 

example, the field “vonMisesStrain” can be saved in the following way. 

1. First, convert the data in the field to the right data type. Right-click on the 
vonMisesStrain field and choose Math Operation….  

2. In the dialog select Convert to Data Type from the first pull-down menu and 
Unsigned Integer 8-Bit from the second. Then click Run.  
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3. A new Volume Image appears under the currently loaded Volume File: Math 
Operation 1. There, the new Volume Field vonMisesStrain Converted to uInt8 

is shown. Right-click on it and choose Save.  

4. Select a name and choose Binary Integer File (*.raw) as file type. Then the 
volume field is saved in the current project folder. 
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MODULE SECTION 

The heading of the Module section changes to the GeoDict module selected from the 
menu bar. The GeoDict modules are organized into modules to Import and pre-

process files and 3D image data, generator and structure-modifying modules to 
Model microstructures, structure analyzing modules to Analyze, properties predictor 

modules to Predict, and modules to Export files to other formats. 

The module section contains a pull-down menu, from which the user can choose a 

command that is executed. Depending on the chosen command, there might be a 
Browse... button for choosing files or an Edit… button, where the options necessary 

for GeoDict’s generators, modifiers, or solvers, can be edited. The Help button 
directly links to the User Guide Reference for the chosen command in the 
corresponding module handbook.  

The module section often includes a Record button, which is selectable when Macro 
→ Start Macro Recording... is selected in the menu bar. Clicking Record allows 

recording the settings and actions of the module without obtaining the results (yet), 

while Run & Record starts the computation and additionally records the action in the 
macro file. 

 

 

 

 

 

 

 

 

Depending on the module, the button Generate, Run, or Export starts the actions 
of the generator, the solver or the export. For ProcessGeo and LayerGeo, the button 

specifies the particular modifying process (Reassign, Rescale, Compress, Attach, 
Erode, Dilate, etc.). 
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For some modules, the module section includes an Estimate Memory or Estimate 

Memory & Disk-Space button, that becomes active for the functionalities that 
support such an estimation. It allows to estimate the memory (and disk-space) 

required for the computation before starting the computation. 

The button Run in Cloud allows to perform the calculations in the GeoDict Cloud. 

More information on how to start a calculation in the cloud can be found in the High 
Performance handbook.  

The use of the modules is explained in each of the module’s handbooks. 

VISUALIZATION AREA AND VISUALIZATION PANEL 

Initially, the Visualization panel shows information about the image displayed in 
the Visualization area. The image might be of a fibrous-, paper-, granular-, 

sintered-, pleated-, woven-, or grid-structure created with one of GeoDict’s structure 
generators, an image from an opened *.gdt file, an image imported and segmented 
with ImportGeo-Vol or ImportGeo-CAD from a stack of 3D image data (µCT, 

FIB/SEM), or other structure models. 

Different parameters or settings 

can be selected in the View menu 
and in the Settings → 

Settings… menu, see page 22. 

The visualization of computational 
results changes the panel, by 

activating other tabs, to access 
options to visualize the results 
optimally.  

Select to view the structure in 2D 
Cross Section (SEM) or 3D 

Rendering mode.  

In 3D Rendering, render the 
structure on the graphics card 

(GPU) or the main processor 
(Box with raycasting or Smooth 

with raycasting). Volume 
raycasting is an image-based 
volume rendering technique that 

computes 2D images from 3D 
volumetric data sets. 

In 2D Cross Section view and 3D Rendering, zoom in and out smoothly by keeping 
the right mouse button clicked and moving the mouse forward and backward. Or 
zoom stepwise by clicking the Zoom buttons on the Camera tab. In 3D Rendering, 

zooming in and out can also be done by scrolling the mouse wheel. 

Select Full Screen to make the Visualization area occupy the entire computer screen. 

Pressing the Esc key on the keyboard returns the program to the normal display. 

When un-checking Structure, the complete structure disappears from the display. In 
the same way loaded results, like Volume Fields, Streamlines, Particles, Triangle 

Mesh, Schlieren, Arrows and Tensors can be switched on and off in the 
visualization. 

To start the visualization of results, a result file must be loaded through File → Load 

Volume Field … or Load Particles … in the menu bar, or directly by loading from 
the Visualization tab of the GeoDict Result Viewer.  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=202&heading=dst_GeoDictCloud
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=202&heading=dst_GeoDictCloud
http://en.wikipedia.org/wiki/Volume_rendering
http://en.wikipedia.org/wiki/Volume_rendering
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Among the Legends / Overlays, unchecking Bounding Box makes the border 

surrounding the domain disappear in 3D Rendering. Unchecking Scale Bar makes 
the scale bar disappear, unchecking Axes hides the coordinate stencil from the 

display while in 2D Cross Section (SEM) or in 3D Rendering. Unchecking Volume 
Field Legend and/or Material Legend hides the legends of a volume field or for the 

constituent materials present in the structure. 

The Particle Time, displayed for a 
particle simulation, the display of the 

GeoDict Logo, and for the 2D cross 
Section view the Status 

Information or the display of the 
Status Bar can be switched on and 
off as well. 

More detailed information about 
visualization in GeoDict can be found 

in the Visualization handbook of the 
User Guide. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

https://www.geodict.com/fileadmin/UserGuide/GeoDict2023/Visualization2023.pdf
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SHORTCUT TO SELECTION AND EDITING FOR GDT AND GAD 

Part of the selection and editing functionalities explained on pages 57 ff. can be 
accessed directly by a right mouse click in the structure shown in the Visualization 

area.  

In this way, voxels and / or GAD objects can be selected and are added to the Voxel 

Selection dialog or the GAD Object Selection dialog.  

Previously selected GAD objects can be removed from the dialog (Deselect GAD 
Object), or the selections of both dialogs can be removed completely (Clear 

Selection). 

After a selection was made, different modifications can be applied to the selection 
(Apply to Selection). Choose Reassign Selected GAD Objects to assign a new 
material ID to the selected objects. 
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With Edit Selected GAD Objects, all objects listed in the GAD Object Selection 

dialog can be modified at once.  

Voxels listed in the Voxel Selection dialog or 

the whole components connected to them, can 
be reassigned to a new Material ID with 

Reassign Selected Voxels or Flood Fill 
Selected Voxel Components. Choose the new 
Material ID for the operation.  

 

 

By a click with the right mouse button on the structure, it is also possible to Edit the 
structure at the point where the right click was performed on without making any 
selection of voxels or GAD objects. Edit GAD Object allows to modify the GAD object 

on which the right click was made.  

Under Domain the current domain can be edited and access to the ProcessGeo 
functionalities Crop and Embed is given.  

With Reassign Material IDs and Materials can be reassigned as it is described in the 
ProcessGeo handbook. When choosing Reassign Material ID, Reassign Material 

or Reassign Material of Material ID, the Material ID or Material at the voxel where 
the right click was made is set as old Material ID or Material. With Reassign Voxel 
at the voxel at this point can be reassigned to another Material ID. Flood-Fill 

Component at is similar to Flood-Fill Component for a selection of voxels (see page 
59), but here for the current voxel. Finally, with Reassign GAD Object the GAD 

Object at this position can be reassigned to a new Material ID. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ProcessGeo&release=2023&heading=Reassign
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Select the options available under Controls, to Reset View settings (also available 

in the Camera tab on the Visualization panel) according to the startup-settings, to 
switch between the icons of the toolbar for the mouse functionalities (Navigate, Edit 

Voxels and Edit GAD Objects), and to change the settings for the Tooltip shown 
for the structure. 

Choose, which information should be shown for the position of the mouse pointer in 
the structure. For the position of a voxel, the coordinates can be shown in number of 
voxels in each direction (Show Voxel Coordinates) or as coordinates in length units 

with respect to the origin of the structure (Show World Coordinates).  

Check Show Voxel Material to add the Material and Material ID information to the 

tooltip. Check Show GAD Information, to show the object type and Object ID of 
the GAD object the voxel belongs to (only shown if analytic object data is available 
for the structure).  

Select Show Volume Field Information (Visible Only) or Show Volume Field 
information (all) to show the value of the currently selected volume field, or of all 

volume fields available, at the current position, if a volume field is loaded for the 
structure. 

 

Use Uncheck All to deselect all boxes of the Tooltip options, or Reset to Default 

Settings to reload the GeoDict default settings for the tooltips. 

 

 

 

Check Infinite Tooltip Duration to prevent the tooltip from vanishing after a few 

seconds.
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GUI SIDEBAR 

Starting with GeoDict 2020, many of the options that were previously available only 
under the View menu in the menu bar, have moved for convenience of usage to the 
sidebar to the right of the GUI.  

Dialogs for Visualization, Color & Visibility Settings, the editing and modifying 
functions (Voxel Selection, GAD Object Selection and Paint mode), the 

measuring of distances and angles (Metrology) and the Session Macro can now 
also be opened directly from the GUI sidebar. 

This sidebar now controls all visualization settings, editing, modifying, and measuring 
functionality centrally. It can be expanded and collapsed by clicking on the  icon 
at the bottom. Each dialog can also be expanded and collapsed by clicking on the  

icon at the top of the tab.  

When expanded, the sidebar panel can be un-

docked by clicking the  icon at the top of the open 
panel and, so, turned into a dialog that can be 
moved around. 

Information about the Visualization tab and the 
Color & Visibility tab from the GUI sidebar can be 
found in detail in the Visualization handbook of the 

User Guide.  

The Session Macro tab is explained in the Automation handbook. 

The functionality of the tabs Voxel Selection, GAD Object Selection, Paint and 
Metrology is explained below. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Automation&release=2023
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WHAT ARE VOXELIZED AND ANALYTIC STRUCTURE MODELS? 

Structure models in GeoDict can be described in two different ways: 

⚫ Analytic representation: The structure is described analytically (e.g. multiple 
spheres with given diameters and positions). The structure information is stored 

as GAD-objects (GAD = GeoDict Analytic Data). 

⚫ Voxel representation: The structure is described by its voxel grid.  

Editing and modification of structure models can be done on the structure’s voxel 

geometry description or analytic description.  

Simple and complicated microstructures can be edited by manual drawing, e.g., to 

correct problematic boundary effects. Among other applications, voxel and analytic 
data editing can be used to remove artifacts from 3D structures built from imported 
3D-image data (micro-CT, nano-CT, SEM, …).  

For structure models created using GeoDict’s generator modules, undesired 
fragments of the structure can be easily modified or eliminated, without having to 

reset the parameters and generate again.  

This direct editing or modification of voxelized structure models is a complement to 
the GadGeo module. GadGeo generates and edits on the analytic level on structures 

with available analytic information, whereas editing is also applicable to structure 
models with voxelized formats.  

Structure models can be manually edited with GeoDict, using the following icons in 
the toolbar: 

Part of the functionality for structure editing can be accessed also by a right mouse 
click in the visualization area, see page 53. 

Here, as a simple structure example, a fibrous media model is generated with 

FiberGeo. The structure consists of 177 GAD objects, but also the voxel representation 
is available. The structure model contains curved fibers of two different raw materials, 

initially set as Manual (Solid).  

Below follow examples to edit and modify this fibrous media model structure in both 
representations. After editing, the structure must be saved to preserve all  

modifications.

2D / 3D 
 

Edit the previously selected voxels. 

2D / 3D 
 

Edit the previously selected analytic objects. 

2D 
 

Edit in a way similar to the Windows standard editor Paint. 

Observe results in 3D (edited objects can be three-
dimensional) 
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VOXEL SELECTION AND EDITING 

The voxel structure is loaded (indicated by the green dot before Structure) and also 
analytical data fitting to the voxel data is available (indicated by the green dot before 

GAD Objects). 

 

 

 

 

 

 

 

 

 

 

We now want to edit the structure by editing the voxels. The analytic object 

information is not modified, and therefore the analytic object description in the model 
does not fit anymore to the loaded structure. The initially green dot before GAD 
Objects turns yellow, if one of the operations listed below is applied. 

The voxels forming a fiber in the structure model are edited in 2D Cross Section (SEM) 
view or in 3D Rendering, as follows: 

1. Select voxels:  

a. Zoom into the structure by pressing and holding the right mouse button while 

moving the mouse back and forth or scroll the mouse wheel. 

b. To enter the Voxel Selection mode, click the corresponding tab in the GUI 

sidebar or the  icon in the toolbar. The Voxel Selection dialog opens.  

c. Click on the voxel(s) that should be edited. For several voxels, press and 

hold the Shift key on the keyboard while clicking the voxels. A cyan-colored 
frame appears at the edges of the selected voxel(s). At the same time, the 
parameters defining the voxel(s) (Position as X, Y, Z coordinates and 

Material ID) appear in a table in the Voxel Selection dialog. 
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d. If a voxel is mistakenly selected, hold Ctrl and click again on that voxel.  

e. Clicking Clear Selection in the Voxel Selection dialog removes all voxels from 

the selection. 

2. Edit voxels by selecting one of the Component Mode commands and clicking 
Run: 

a. Flood-Fill Component: Fill the selected voxels and the components connected 

to them (see page 26) with a New Material ID chosen from the pull-down 
menu.  

 

b. Flood-Fill Component Plane: Fill the selected voxels and the components 

connected to them with a New Material ID only in the Plane chosen from the 
pull-down menu.  
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c. Reassign Material of Objects (*.g32): If a *.g32 file with object indices is 
loaded in the GeoDict GUI (e.g., created by right clicking on Objects in the 

Project Status Section and selecting Create GAD Index Image, see page 42), 
the Object ID is additionally shown for each voxel selected. 

Select a New Material ID and click Run, to assign the new material to all 
voxels that belong to the same Object ID as the voxels selected (here Object 

IDs 76, 104 and 163). 
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d. Reassign Material of Selected Voxels: The material ID of the selected voxels 

can be changed by selecting a New Material ID from the pull-down menu. 

e. Dilate Selected Voxels: It is possible to dilate the voxels by coating them 

with another material chosen from the Coating Material ID pull-down menu 
by a certain number of voxels (Dilate by). An explanation for the dilate 
command can be found in the ProcessGeo handbook of this User Guide. 

 

f. Dilate Component: Also possible is to dilate the selected voxels and the 

components connected to them with the Coating Material ID by a certain 
number of voxels (Dilate by). 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ProcessGeo&release=2023&heading=Dilate
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g. Dilate Component Plane: Dilate the selected voxels and the components 

connected to them only in the Plane chosen from the pull-down menu with the 
Coating Material ID by a certain number of voxels (Dilate by). 

 

 

All these operations can be undone by clicking the  icon or CTRL+Z. 
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GAD OBJECT SELECTION AND EDITING 

The same fibrous media model as in the section 
above is edited, but now the analytic objects are 

modified. This is possible if a structure in GAD 
format is loaded, or a structure in GDT file format 

with analytic object information contained in the 
GDT file. The information that appears in both cases 
in the Project Status, is equivalent.  

In contrast to editing the voxel structure, editing 
the analytic objects preserves the analytic object 

information in the file. 

 

The analytic objects (fibers) in this fibrous structure model can be edited, while 

visualizing the material model in 2D Cross Section (SEM) view or in 3D Rendering, as 
follows: 

 

 

 

 

 

 

 

 

1. Select analytic objects:  

a. To enter the GAD Object Selection mode, click the corresponding tab  in 

the GUI sidebar or the  icon in the toolbar. The GAD Object Selection 

dialog opens.  

b. The upper table shows the ID number and the Object Type of the selected 
fibers. 

c. Click on the fiber that should be edited to select it. For several fibers, press and 
hold the Shift key on the keyboard while clicking the fibers. The selected fiber(s) 

appear(s) highlighted. 

d. If a fiber is mistakenly selected, press and hold the CTRL key and click on the 
fiber again. 

2. Edit analytic objects: 

a. When clicking Delete Objects, all selected fibers, which are listed in the upper 
table, are deleted and taken out from the structure model. 

b. Change Material ID: The material ID of the selected objects can be changed 

by selecting a new material ID from the pull-down menu and clicking Change 
Material ID. 
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The selected fiber(s) still appear(s) highlighted (and perhaps makes it difficult to see 

the change in the material) until the user clicks Clear Selection. 

Now the fibrous structure model contains fibers of three different materials. 

 

 

 

 

 

 

 

 

 

 

It is also possible to Edit Objects in a dialog which looks similar to the GadGeo 
Edit GAD Objects dialog, but it contains only the chosen GAD Objects. With a 
right click on a single selected object the Edit menu for only this object can be 

opened. The GadGeo handbook describes how the GAD Objects can be edited.

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2023&heading=GadEdit
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PAINT 

The Paint Mode editing works in a way similar to the Windows standard editor Paint. 

Editing is always done in 2D (View → 2D Cross-Section (SEM)) and the effects can be 

seen later in 3D (View → 3D Rendering). 

The Paint Mode operates directly on the voxel representation of a structure. Thus, 
using the paint mode on a structure with analytic object information does not change 
the analytic data. This can be observed in the green dot before GAD Objects turning 

yellow in the Project Status section after applying the paint mode. After editing in 
the paint mode, the changed structure must be saved to store the modifications. 

As an example, a fibrous media model is edited with Paint Mode.  

 

 

 

 

 

 

 

The Paint mode is used as follows: 

1. Select View → 2D Cross-Section (SEM) in the menu bar or click the  icon in 

the toolbar.  

In the Visualization panel, above the Visualization area, click the Camera (Y, Z) 

tab and use the Direction pull-down menu and the Slice slider to navigate to the 
location where the editing should take place. Here, direction Z and slice 90 is 
selected. 
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2. Click the Paint tab on the GUI sidebar or the  icon in the toolbar to open the 

Paint Settings dialog. The Paint tab is greyed out and not accessible when the 
structure is viewed in 3D rendering. 

3. In the opening Paint Settings dialog, editing is done using a brush (Make sure, 

that the  icon is selected, so that the brush is active!) and its shape and size 

are set in the Brush Shape pull-down menu and in the Brush Length 
(Diameter) X, Brush Length (Diameter) Y and Brush Length (Diameter) Z 

boxes. The brush size is given in voxels. 

The brush shape can be a Box, with the side lengths entered in Brush Length X, 

Y, and Z, or a Sphere (Ellipsoid) 
with the diameters entered in 

Brush Diameter X, Y, and Z.  

The Material ID of the material to 
draw with is chosen from the 

Material ID pull-down menu.  

The choice of Brush Mode in the 

pull-down menu determines the 
working technique for the brush. 
With Set, the selected material 

replaces the original material. 
With Add and Subtract, 

material is added to or 
subtracted (removed) from the 
original material. With Replace, 

material of a selected ID is 
replaced by a new material. 

The Draw Mode defines whether 
the brush stroke is applied for 
Continuous drawing, for a 

Single Click or for drawing a 
Straight Line. 

4. The brush strokes, in the selected shape, size, and Material ID (here Sphere 
(Ellipsoid), diameter 5 x 5 x 10 voxels, Material ID 03), are applied by pressing 

and moving (for Continuous Drawing and Drawing Straight Lines) and by 
clicking (for Single Click Drawing) with the left mouse button in the desired 

position.  

Strokes at different spatial locations are applied by selecting a different Direction 
(X, Y, or Z) and/or a different Slice in the Visualization panel, above the 

Visualization area.  

The effects of editing (in 2D view) are observed as soon as the left mouse button 

is released. Here, voxels of material ID 00 have been replaced by voxels of Material 
ID 03, which are blue. After editing, close the Paint Settings dialog and switch to 
3D rendering.  
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For Draw Mode Continuous, press the left mouse button while dragging the 

mouse. Moving the mouse too fast results in an irregularly dashed line.  

Use Draw Mode Single Click by clicking the left mouse button in different locations 
of the 2D view of the structure model. The effects of editing (in 2D view) are observed 

as soon as the left mouse button is released. After editing (in 2D view), close the 
Paint Settings dialog and switch to 3D rendering. 
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Use Draw Mode Straight Line by clicking the left mouse button and drawing the 

line to the desired end point while holding the mouse button clicked.  

The brush modes Set, Add, Subtract and 

Replace may be selected from the pull-down 
menu Brush Mode. When using Add or Subtract, 
material intersections occur, where the Material ID 

of the addition or the subtraction is given by 
adding or subtracting the binary numbers of the 

Material ID codes column-wise. This is shown in 
the next example and explained below on page 71 
ff. in more detail. 

In the following example, to better observe 
material intersections, the GeoDict built-in red-

green-yellow-blue color scheme is used.  

This color scheme is obtained by selecting 
Settings → Color & Visibility Settings… and 

clicking the  icon at the bottom of the dialog 
(Load built-in default settings). 
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For this example, two slabs were created with 5x20x5 voxels each. The painting is 

done in the X-Y-plane on slice 12. 

 

In Set mode, the chosen Material ID completely fills the voxels, so that original 
materials are replaced. The replacement of material is clearly seen in 3D rendering:  

 

 

In Add mode, the selected Material ID does not fill the voxels, but an intersecting 
material is built.  

According to GeoDict’s rules on defining new material IDs for intersecting materials 
(see below on page 71), adding voxels of material ID 04 (blue) to material ID 01 (red) 
results in intersected voxels of material ID 05 (violet-colored). Material ID 04 added 

to material ID 02 (green) results in intersected voxels of material ID 06 (cyan-
colored). And Material ID 04 added to Material ID 00 (porous space) results in Material 

ID 04. The intersecting materials are also shown below in 3D rendering. 
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In Subtract mode, the selected Material ID is bit-wise subtracted from the existing 
structure where the brush is applied (see below page 71).  

 

 



GeoDict Graphical User Interface – GUI sidebar 

GeoDict 2023 User Guide  71 

In Replace mode, the selected Material ID replaces the Replace ID, not selected 

Material IDs are unaffected by the modification. 

INTERSECTING MATERIAL IDS FOR ADD AND SUBTRACT MODES 

With the GeoDict built-in color settings, 256 Material IDs are available. 

In Add and in Subtract edit mode, when two materials are added or subtracted, the 
Material ID of the addition or the subtraction is given by adding or subtracting the 

binary codes corresponding to the Material IDs. The used calculation rules are shown 
below. 

 

 

 

 

 

 

The addition or subtraction of Material IDs is done column-wise, as follows: 

 

 

 

 

 

Binary addition rules  Binary subtraction rules 

1 + 1 = 1  1 - 1 = 0 

1 + 0 = 1  1 - 0 = 1 

0 + 1 = 1  0 - 1 = 0 

0 + 0 = 0  0 - 0 = 0 

0 0 0 1 
 

+ + + + + 

0 0 1 1 
 

= = = = = 

0 0 1 1 
 

0 0 0 1  

- - - - - 

0 0 1 1  

= = = = = 

0 0 0 0  
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Examples of Material ID and binary codes of intersection materials obtained by 

adding: 

First material Second material Intersection material 

Material ID 
Binary 

code 
Material ID 

Binary 

code 
Material ID Binary Code 

 0010  0100  0010 + 0100 = 0110 

 0011  0100  0011 + 0100 = 0111 

 0011  0101  0011 + 0101 = 0111 

 0101  0001  0101 + 0001 = 0101 

Examples of Material ID and binary codes of intersection materials obtained by 
subtracting are: 

First material Second material Intersection material 

Material ID 
Binary 

code 
Material ID 

Binary 

code 
Material ID Binary code 

 0001  0001  0001 – 0001 = 0000 

 0101  0010  0101 - 0010 = 0101 

 0011  0001  0011 - 0001 = 0010 

 0100  0001  0100 – 0001 = 0100 
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METROLOGY 

With the Metrology functionality, distances and angles can be measured in the 2D 
View of a structure.  

Select View → 2D Cross Section (SEM) in the 

menu bar.  

Click the Metrology tab on the GUI sidebar or click 

the icon  in the toolbar to open the Measure 
Angles and Distances dialog.  

In the Camera tab of the Visualization panel, 

choose the Direction (X, Y or Z) and the Slice of 
the structure for the measurement. 

To start a new measurement, first select from the 

New Measurement Settings if a Distance, an 
Angle or Angle and Distance should be 

measured. 

Next, in Snap to grid, define if points should be 

selected freely in the structure (Free Placement), 
or be snapped to the nearest voxel centers, voxel 
corners or edge centers. 

In the Visualization Settings, choose the Line 
Thickness and Color for the visualization of the 

measurement. 

To start measuring, click with the left mouse button 
at the position, where the measurement should be 

started and left-click again at the desired end point. 
If the measurement should be canceled, just click 

with the right mouse button. 

In the example shown here, the diameter of the red 
fiber in X-direction is measured. 

 

 

 

The differences between the snap options can be observed if the visibility of the grid 
is turned on. 
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For the  Active Measurement, the measured 

distance and/or measured angle is shown.  

Check Hide to hide the measurement and the 
text in the visualization area, or uncheck Show 

Distance, to hide only the text. 

With Delete Measurement, the measurement 

currently active is deleted from the panel. 

These options are especially helpful when 
several measurements are available in the 

panel. 

Create e.g., a second measurement, measuring 

the length of the gray fiber segment and its 
angle to the X-axis. For this, set the options for 
this new measurement to Angle and Distance. 

As snap mode Snap to Voxel Corners was 
chosen. 

First, the desired distance is measured, then this 
measure line is taken as first angle leg and the 
angle can be measured with a third click. 
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Uncheck Show Angle to hide the text next to the measured angle. 

The angle of the segment is shown counterclockwise, as long as Counterclockwise 

Angle is checked. 

 

Clicking Adjust Voxel Length, opens a dialog to change the voxel length of the 
structure accordingly to the measured line. Enter the desired length of the measured 
line (in the example 8.5 µm instead of the 8 µm measured in Measurement 1) and 

click OK. The voxel length of the whole structure is rescaled to match the desired 
length. Check Rescale all volume fields, to rescale also the volume fields to the 

new voxel length. 
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In the All Measurements part of the panel, all available 

measurements, can be hidden by checking Hide All or 
deleted with Delete All Measurements. 

The measurements can also be saved in a *.gdr file by 
clicking Save Measurements. A dialog opens, where 

the desired result file name can be entered.  

 

Choose Lock Measurements in the Editing 

Settings part of the panel to move the whole line of 
a measured distance and/or angle to another 
location. If Lock Measurements is unchecked, the 

end point of a measurement can be modified.
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CONSOLE AND NOTIFICATIONS 

The console and notifications panels are located at the bottom of the GUI, under the 

visualization area. The Console panel is a textual GUI window and log viewer. The 
console allows to read the system logs, help find certain ones, monitor them, and 

filter their contents. Additionally, the user can enter and execute python commands 
directly in the console (for more details, see the Automation by scripting handbook 
of this User Guide).  

The console panel can be folded and unfolded by clicking on the   icon. 

When expanded, the panel can be un-docked and turned into a dialog that can move 

around. Undocking is done by clicking the  icon, located at the top right after 

expanding. The console can also be closed by clicking on . 

The Notifications panel is new in GeoDict 2023 can be opened and closed in the 

same way by clicking on the  icon.  

 

A right click in the console panel provides further 
options to filter and read the information 

displayed. Text in the console can be marked 
with the cursor and exported to another program 

by using Copy. With Select All the whole text in 
the console is marked. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Automation&release=2023
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Check the boxes to Show GeoDict Messages, Show GeoDict Output, Show 

GeoPython Messages and Show Solver Messages. During each GeoDict session 
a log file, that contains all outputs from the console, is written and saved in 

%username&/geodict2023/log (Windows) or %username%/.geodict2023/log 
(Linux). With Open Log File it is opened in the chosen text editor (see page 22 ff.). 
Use Zoom in and Zoom out to enlarge or reduce the font size of the console. 

 

Messages from GeoDict, which are shown in the console, are also shown in the 
Notifications panel.  

The list shows the Time, when a message was raised, the icon shows the Type of 
the message, also the Title and the Message itself are given. With a right click in 
the corresponding field the title and the message text can be copied to the clipboard 

to save them e.g. in a text editor. This can be helpful, if a message boxed was closed 
and the user wants to re-read the message. Another advantage is, that the user 

does not have to scroll through the console, where other output from GeoDict is 
listed. 

With the filter options it is possible to show only Critical Errors, Warnings and/or 

Information. With Clear Notifications all messages from the list can be deleted. 
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